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Preface 

About CubeMaster  

Congratulations on purchasing CubeMaster, a 3D graphic-based simulation program that optimizes the 

packing and loading problem in the Supply Chain. This provides the various and cost-effective solutions for 

the loading of pallet, truck and pallet on the basis of the high-tech research and a lot of site experience. In 

addition, this provides the optimal loading pattern through the intelligent simulation and the standardized 

workflow through the best practice. 

This supports below business. 

Á Planning a loading of truck, sea and air container 

Á Calculating the optimal amount of the shipment and the distribution 

Á Calculating the optimal number of the containers to negotiate the sales order (or forecasting the 

order quantity) 

Á Calculating the weight distribution and the maximum efficiency of the space 

Á Deciding the optimal specification for the product and the cargo box 

Á Automatically publishing the 3D work order for the loading and unloading 

Á Sharing the work order and cargo report through the Internet (only in case of Web version) 

For over 10 years, LOGEN Solutions has been the industry's premier vehicle/container loading system 

provider. CubeMaster offers a sequenced loading report, along with a variety of ways to display the load, 

such as sequenced 3-dimensional color/number coded load diagrams and placement-by-placement displays. 

CubeMaster also has the ability to construct straight and mixed pallets. With CubeMaster, you can accurately 

plan your vehicle/container loads in advance, resulting in increased efficiency and better customer support. 

Over the years, we've maintained a steady effort to simplify our software so that you, the end user, are able to 

conduct your loading analysis quickly and efficiently. Just in case you have a problem, we've written this 

User's Guide to assist you with every possible issue or question you might have. 

If this User's Guide does not answer your questions, or if you should experience problems while using 

CubeMaster software, please call LOGEN Solutions Technical Support or your VMS sales representative. 

Benefits 

The below benefits can be made with CubeMaster; 

Á Improving the productivity of the logistics affair 

¶ Reducing the wasted space and over-load through calculating the optimal efficiency of loading 

and the minimal number of the containers (increase the efficiency of loading by 10 ~ 15%) 

¶ Eliminating the waste resulting from the non-professional man power (diminish the labor cost 

by mean 30%) 

¶ Increasing the speed of the business through the easy user interface 

¶ Improving the productivity of the business and reducing the cost of shipment and distribution 

Á Enforcing the consistent management through the whole business 

¶ Able to manage the 3D graphic-based visible verification 

¶ Increasing the speed of the business and preventing the error by computerization 

¶ Enhancing the rapid response to the increasing operations 



  

Á Enhancing the flexibility of the logistics 

¶ Easy to response rapidly to the changing customerôs needs and the market trend 

¶ Enhancing the rapid flexibility by absorption of the unexpected change into the normal process 

and diminishing the temporary actions 

¶ Enhancing the operation ability by using the non-professional 

¶ Responding the increasing business by computerization and automation 

Terminology 

The terms that are often used in the program may be described here. 

Container: All actual vessels or spaces will be called as ñcontainerò including the carton, pallet, truck, sea 

van and air container, etc. They have the three dimensional length on each axes (x, y, z) called the length, 

width and height and they form a rectangular parallelepiped. 

Cargo: Cargo originally means the basic handling unit for stock and delivery. However, this term is, in 

CubeMaster, will be defined as the basic object to be loaded in a container during the simulation. If one 

product has the specification data on the fixed length * width * height, this can be identified as cargo. A pallet 

with several cartons stacked on it will be used as cargo also, where its dimension will be the size of outside of 

the pallet.  

Net Weight: The net weight of the product. 

Gross Weight: The gross weight of the product. It includes the weight of the packaging materials (pallet, 

corrugated cardboard and reinforcing agent, etc.) 

CBM (Cubic Meters): This is the unit into that the arithmetic volume is converted in meter. The length, 

width and height of the product multiply with each other and then are notated in meter for ease. This unit is 

widely used to calculate the freight rates for the loading onto the ship or aircraft. In case of the general sea 

container for the export, a 20FT container has the dimension of 2.35m x 5.89m x 2.39m(length x width x 

height) and a 40FT container 2.35m x 12.03m x 2.39m (the different makers can make different container 

types), which multiply into 33CBM for the 20FT container and 67CBM for the 40FT container. 

Corner Castings : This is the structure attached onto ceil of the sea van for the crane lifting. Its 3 dimension 

should be defined with container together when a load data is defined before running the simulation. 

Length

Width

Height

 

Figure 1 Three Dimensional Corner Castings  

Load Orientations: This is one of the directions of the cargo that is earthed to the bottom of the container. In 

case of the rectangular parallelepiped cargo, 6 directions can be used. The user can take 4 turning directions 

as well as 2 basic directions.  



  

Loaded Container: This is a result of the simulation. It is a container filled with several Cargoes and several 

empty spaces where the cargo does not occupy. This will be shown at the container list with the column of the 

container name, the number of cargo loaded in the container and the volume efficiency, etc. 

Unused Space: This is the 3D space where cargo is not located in the container. In order to maximize the 

loading efficiency of the container under the given constraints, it is inevitable to make some unused spaces. 

Simulation Workflow 

CubeMaster provides five task views. They have independent functions and are linked each view. You should 

understand the simulation workflow in order to understand these views. 

Simulation workflow is defined as the sequential chain of the steps as below. 

 

These steps are implemented through five task views.  

Step1: Setup  Load  
Å Select load type 

Å Build cargo list 
Å Define container types 
Å Define rules (stacking, orientation)  

Step2: Calculate Load  
Å Find the solutions in a few seconds 

Step3: Analyze  Load  
Å Browse the solutions 
Å Reuse the unused spaces 
Å Edit the loaded patterns by manual 

Step4: Build Reports  

Å Generate reports from the solutions 
Å Send the reports via email 

Step5: Manage Loads  
Å Save/open the loads to/from a file 
Å Modify/delete the exsting loads 

Step6: Manage Database  
Å Manage cargoes database 
Å Manage containers database 



  

Getting Started 

System Requirements/Specifications 

To install and run CubeMaster software, your system needs to meet the following requirements: 

Á Platform: Windows 2000, NT, XP (Windows 95, ME, 98 is NOT available) 

Á Network: Any network is compatible. CubeMaster2003 is not network protocol dependent; it only 

needs a file server. 

Á Processor Required: Any processor capable of running the installed platform (200 MHz 

Recommended). 

Á Hard Disk Space Required: 30 MB 

Á RAM Required: 16 MB (32 MB or more Recommended) 

Á Video Required: 800 x 600 at 256 colors or higher (1024 x 768 Recommended) 

CubeMaster software uses 32-bit code. For import/export of data, CubeMaster uses ASCII comma delimited 

text files compatible with most document management systems, spreadsheets, databases and mainframes, 

including Excel, Access, Paradox, AS400 and UNIX platforms. 

Starting CubeMaster 

Installing the Program 

The following instructions describe how to install CubeMaster on your PC. 

Á Insert the installation CD into your driver 

Á Click [start] menu at task bar and select [Run] menu 

Á Enter the following command and press enter key. 

[Your CD driver name]: \\CubeMasterSetup.exe 

Á Or locate the file ï CubeMasterSetup.exe from the windows explorer and launch the program by 

double click the left button of your mouse or press the enter key at your keyboard. 

Á You will meet the below screen displaying the information of installation guide. Just follow the 

guide of the program to install CubeMaster. 



  

 

Figure 2 Screen of Installation  

Installing the Hardware Lock key Driver  

You should install the driver for hardware lock key in case the hardware lock key is the parallel type and your 

operating system is Windows NT/2000 also. 

Á Enter the following command and press enter key. 

[Your CD driver name]: \\SetupLockkeyDriver.exe 

Á Just follow the guide of the program to install it. 

Starting the Program 

Before launching the program you may need to insert the hardware lock key into the printer port or USB 

port at your computer. 

 

Figure 3 Copy Protection  Key (USB Type)  

After then click [Start] menu at task bar and select [Program] menu and select [CubeMaster Desktop] from 

[VMS] in order to start the program. 



  

Troubleshooting 

ERROR MESSAGE WHEN LOCK KEY IS MISSING ON THE PROGRAM STARTING . 

 

Figure 4 Error message on missing lock key  

CubeMaster requires the hardware lock key installed at the computer to verify the license.This screen may 

appear when you didnôt insert the lock key into the USB port at your computer. You may need to insert it to 

make CubeMaster start correctly. 



  

The Basics 

In this chapter, the basic configuration of CubeMaster will be described. 

Common Features 

CubeMaster has similar interfaces as Microsoft Outlook Express. It provides rich ways for you to handle the 

simulations workflow including entering load data, running simulation and retrieving results of the simulation.  

The following picture gives conceptual view of the structure of interfaces. You can see the several bars and 

task-view area that will be occupied by five task views. The task views are activated by clicking the icons in 

Task Bar at left of the program. 

  

Figure 5 Conceptual View of Screen  

Menu Bar: This is composed of the classified functions for the userôs convenience. If each menu selected, 

the sub-menu will appear. And if the desired item selected, the item will execute the command.  

Tool Bar: The menu items used commonly will be shown in the form of icon. 

 

Figure 6 Tool Bar 

Task Bar: It contains the shortcut icons to five task views.  

Task-view Area: It will be occupied by five task views. 

Tab System: CubeMaster uses tabs throughout the system.  Tabs allow you to quickly and easily switch back 

and forth between different data entry areas or sub-screens.  

Menu Bar  

Tool  Bar  

Task  Bar  

Task View 
Area  



  

  

Figure 7 Example of Tab Systems  

Open an Existing Simulation 

Use one of two options in order to open an existing simulation. 

¶ Open the [File] menu and select [Open]. 

¶ Go to the Today view, select a file name to open and click [Open] button. 

Start New Simulation 

Use one of two options in order to start a new simulation. 

¶ Open the [File] menu and select [New]. 

¶ Go to the Today view and click [New] button. 

Exit the Program 

In order to exit CubeMaster, open the [File] menu and select [Exit]. If youôve made any changes since you 

last saved the active file, CubeMaster prompts you to save the file.  If you need to save any changes, click 

[Yes]. CubeMaster saves your changes and shuts down the system. 



  

Define Databases 

Introduction 

As you set up the CubeMaster system and prepare to use it in your daily operations, one of the most critical 

functions is setting up the various databases. CubeMaster uses a local database ñC:\Program Files\Common 

Files\VMS Shared\Database\VMSDB2010.mdbò that is in the format of Microsoft Access 2003.  

Before we begin this chapter, it is important to remember one critical fact: 

A computer does not think like a human. Therefore, it's imperative that all inputs and measurements be 

precise. For example, think of a space as tiny as 1/16 of an inch. While you and I may think nothing of such a 

small number, and certainly would not think it could affect the way a truck is loaded, CubeMaster thinks 

otherwise. 

For a computer, everything is ñblack and white.ò An object will either fit or it wonôt. Letôs take a truck that is 

99ò wide. Suppose you want to place three refrigerators side by side across the nose of the truck; each 

refrigerator is 331/16ò wide. A quick calculation shows that 3 ³ 331/16 equals 993/16, which is greater than 

99ò. 

Therefore, CubeMaster will not place these refrigerators side by side. If you ever run across a situation like 

this, double-check the dimensions of both your truck and your cargo. Are they exact dimensions? Also, 

remember that humans may tolerate a ñfudge factor.ò Perhaps the person loading the truck will make these 

refrigerators fit. CubeMaster, however, will not. 

When you define databases in the CubeMaster system, you'll always start with the Database view. Use one of 

two options in order to open this view. 

¶ Open the [View] menu and select [Database] 

¶ From the Task List, click [Database] button 

 

This topic walks you through how to define six types of databases. 

¶ Cargoes  

¶ Carton 

¶ Pallet 

¶ Truck 

¶ Sea Van 

¶ Unit Load Device/Air Pallet (ULD) 



  

Cargo Databases 

A cargo is defined as any object that you will load into a vehicle, onto a pallet, or into a tote. CubeMaster 

currently gives you the option of defining two types of cargoes: Shipcases and PalletLoads.  

The cargo Database view allows you to define a new cargo or modify an existing cargo. In this view, you 

enter cargo parameters and save it to the cargo database. Start from the Task Bar and click the Database menu 

and select cargo. 

System Response: The cargo Database view appears, as pictured below. 

 

Figure 8 Cargo Database View  

The Cargo Database view is comprised of the following components: 

¶ New Button: Allows you to define a new cargo. 

¶ Delete Button: Allows you to delete Cargoes from the database. This button will be activated on 

when you select more than one cargo at the cargo List. In order to make a selection, click a row 

header of the leftmost column at the list and drag the mouse to the end of range. The list will 

highlight the range and the button activates. 

¶ Append External Button: Allows you to import Cargoes from another system to the local database 

of CubeMaster. 

¶ Cargo List: Displays a list of all cargoes existing in the database. It allows you to modify the 

parameters of cargo and saves the changes to the database automatically. 

CARGO LIST  

When you click on a cargo data, a black bar highlights it. The gray vertical scroll bar to the right of the box 

scrolls the database list and allows you to view more cargoes. The scroll bar will take you to the bottom of the 

list or to the top of the list. When you click on a cell, a black color highlights it and be ready for you to enter a 

new value. If you enter a return key when you complete to type a value, the right cell will gain the highlight 

again. 

This list contains useful information about the cargo. All of this information is designed to help you make 

quick and easy decisions about the items youôre shipping. 



  

¶ Group Name: This column contains the group name of cargo. 

¶ Name: This column contains the cargo name.  

¶ Length, Width and Height: This columns display the dimensions of each cargo. The dimensions 

will appear either in English or Metric units, depending on which units are selected in the Toolbar. 

¶ Weight: This column displays the defined weight of each cargo. As with the dimensions columns, 

this column will either appear in English or Metric units, depending on which units are selected in 

the Toolbar. 

¶ Volume: This column displays the volume of each cargo. The volume is calculated automatically 

from the dimensions whenever you change them thus you are not allowed changing it. It will 

appear either in English or Metric units, depending on which units are selected in the Toolbar. 

¶ Color: This column displays the color of each cargo. Click on this column to display the Color 

Selection dialog box. CubeMaster uses the standard (48-color) Windows Color Selection dialog 

box, which allows you to select a custom color for each cargo.  

¶ Seq.: This column displays the load sequence of each cargo. The load sequence allows you to define 

the relative importance of a particular cargo when loading into a vehicle. Please note that you 

should activate the Load Sequence rule at the More Rule window even you defined this parameter. 

All cargoesô with a sequence of ñ1ò will be loaded before cargoes with a sequence of ñ2,ò which 

are loaded before cargoes with a sequence of ñ3,ò and so on. This means that all cargoes with a 

sequence of ñ1ò will generally be loaded before (and therefore in the front of the vehicle) cargoes 

with a higher sequence value.  

If there's not enough room to load all cargoes with a particular sequence value, CubeMaster will 

load as much of the sequence as possible, leaving the remaining cargoes. In other words, sequence 

can be split-up.  

¶ Stack Value: This column displays the stack value of each cargo. The stack value allows you to 

define the relative stacking position onto a vehicle. Please note that you should activate the 

Stacking rule at the More Rule window even you defined this parameter.  

All cargoesô with a stack value of ñ1ò will be stacked on cargoes with a stack value ñ2,ò which are 

stacked on cargoes with a stack value of ñ3,ò and so on. This means that all cargoes with a stack 

value of ñ1ò will generally be stacked on (and therefore in the front of the vehicle) cargoes with a 

higher stack value. 

Modify an existing cargo 

To modify an existing cargo, follow these instructions; 

1. Select a row of the cargo you want to modify 

2. Modify information of each cell as you necessary 

3. Whenever you leave each cell after modifying it, CubeMaster saves the changes to the cargo 

database automatically 

Define a new cargo 

To define a new cargo, follow these instructions; 

1. Click the New button 

System Response: A new row is appended at the bottom of the list and the focus locates on the 

Name cell 

2. Modify information of each cell as you necessary 

3. Whenever you leave each cell after modifying it, CubeMaster saves the changes to the cargo 

database automatically 



  

Delete a cargo from the database 

To delete an existing cargo, follow these instructions; 

1. Select rows of the Cargoes you want to delete 

2. Click the row-number heads to highlight the rows 

System Response: The Delete button is activated 

3. Click the Delete button 

System Response: The selected rows are deleted from the database and removed from the list 

Import cargoes from another system 

To import cargo data from another system, follow these instructions;  

1. Click the Import External button 

System Response: A message window prompts you to confirm the command as the following 

picture. If you confirm it, the cargo Data Source window appears and allows you to choose a data 

source type where to import from.  

 

Figure 9 Cargo Import Messag e Window  

2. Select a data source type from the cargo Data Source window 

3. Click the OK button to close the window 

System Response: CubeMaster imports Cargoes from the selected data source and saves them to the 

cargo database 

System Response: Imported Cargoes appear at the bottom of the list and a message window shows 

the number of records imported 

To understand more about the Data Source, please see the section Import from External Database.  

 



  

Carton Databases 

A carton is defined as shipcase, tote or corrugated box that you will fill with Cargoes.  

The Carton Database view allows you to define a new carton or modify an existing carton. In this view, you 

enter carton parameters and save it to the carton database. Start from the Task Bar and click the Database 

menu and select Carton. 

System Response: The Carton Database view appears. 

The Carton Database view is comprised of the following components: 

¶ New Button: Allows you to define a new carton.  

¶ Delete Button: Allows you to delete cartons from the database. This button will be activated on 

when you select more than one carton at the Carton List. In order to make a selection, click a row 

header of the leftmost column at the list and drag the mouse to the end of range. The list will 

highlight the range and the button activates. 

¶ Carton List: Displays a list of all cartons existing in the database. It allows you to modify the 

parameters of carton and saves the changes to the database automatically. 

Carton List  

When you click on a carton data, a black bar highlights it. The gray vertical scroll bar to the right of the box 

scrolls the database list and allows you to view more cartons. The scroll bar will take you to the bottom of the 

list or to the top of the list. When you click on a cell, a black color highlights it and be ready for you to enter a 

new value. If you enter a return key when you complete to type a value, the right cell will gain the highlight 

again. 

This list contains useful information about the carton. All of this information is designed to help you make 

quick and easy decisions about the container youôre loading. 

¶ Define Button: This column allows you to define more parameters of carton. 

¶ Name: This column contains the carton name.  

¶ Length, Width and Height: This columns display the dimensions of each carton. The dimensions 

will appear either in English or Metric units, depending on which units are selected in the Toolbar. 

¶ Weight: This column displays the defined weight of each carton. As with the dimensions columns, 

this column will either appear in English or Metric units, depending on which units are selected in 

the Toolbar. 

¶ Max Weight: This column displays the max weight of each carton. As with the dimensions columns, 

this column will either appear in English or Metric units, depending on which units are selected in 

the Toolbar. 

¶ Color: This column displays the color of each carton. Click on this column to display the Color 

Selection dialog box. CubeMaster uses the standard (48-color) Windows Color Selection dialog 

box, which allows you to select a custom color for each carton.  

Modify an existing carton 

To modify an existing carton, follow these instructions; 

1. Select a row of the carton you want to modify 

2. Modify information of each cell as you necessary 

3. Or click the Define button 

System Response: The Carton Properties window appears and allows you to define more 

parameters of the carton 



  

 

Figure 10 Carton Define Window  

4. Whenever you leave each cell after modifying it, CubeMaster saves the changes to the carton 

database automatically 

Define a new carton 

To define a new carton, follow these instructions; 

1. Click the New button 

System Response: A new row is appended at the bottom of the list and the focus locates on the 

Name cell 

2. Modify information of each cell as you necessary 

3. Whenever you leave each cell after modifying it, CubeMaster saves the changes to the carton 

database automatically 

Delete an carton from the database 

To delete an existing carton, follow these instructions; 

1. Select rows of the carton you want to delete 

2. Click the row-number heads to highlight the rows 

System Response: The Delete button is activated 

3. Click the Delete button 

System Response: The selected rows are deleted from the database and removed from the list 



  

Pallet Databases 

The Pallet Database view allows you to define a new pallet or modify an existing pallet. In this view, you 

enter pallet parameters and save it to the pallet database. Start from the Task Bar and click the Database menu 

and select Pallet. 

System Response: The Pallet Database view appears. 

The Pallet Database view is comprised of the following components: 

¶ New Button: Allows you to define a new pallet.  

¶ Delete Button: Allows you to delete pallets from the database. This button will be activated on when 

you select more than one pallet at the Pallet List. In order to make a selection, click a row header of 

the leftmost column at the list and drag the mouse to the end of range. The list will highlight the 

range and the button activates. 

¶ Pallet List: Displays a list of all pallets existing in the database. It allows you to modify the 

parameters of pallet and saves the changes to the database automatically. 

Pallet List  

When you click on a pallet data, a black bar highlights it. The gray vertical scroll bar to the right of the box 

scrolls the database list and allows you to view more pallets. The scroll bar will take you to the bottom of the 

list or to the top of the list. When you click on a cell, a black color highlights it and be ready for you to enter a 

new value. If you enter a return key when you complete to type a value, the right cell will gain the highlight 

again. 

This list contains useful information about the pallet.  

¶ Define Button: This column allows you to define more parameters of pallet. 

¶ Name: This column contains the pallet name.  

¶ Alias1: This column contains the alias of each pallet. 

¶ Length, Width and Thickness: This columns display the dimensions of each pallet. The dimensions 

will appear either in English or Metric units, depending on which units are selected in the Toolbar. 

¶ Max Height: This column displays the max height including the thickness of each pallet. As with 

the dimensions columns, this column will either appear in English or Metric units, depending on 

which units are selected in the Toolbar. 

¶ Weight: This column displays the defined weight of each pallet. As with the dimensions columns, 

this column will either appear in English or Metric units, depending on which units are selected in 

the Toolbar. 

¶ Max Weight: This column displays the max weight of each pallet. As with the dimensions columns, 

this column will either appear in English or Metric units, depending on which units are selected in 

the Toolbar. 

¶ Color: This column displays the color of each pallet. Click on this column to display the Color 

Selection dialog box. CubeMaster uses the standard (48-color) Windows Color Selection dialog 

box, which allows you to select a custom color for each pallet.  

Modify an existing pallet 

To modify an existing pallet, follow these instructions; 

1. Select a row of the pallet you want to modify 

2. Modify information of each cell as you necessary 

3. Or click the Define button 



  

System Response: The Pallet Properties window appears and allows you to define more parameters 

of the pallet 

 

Figure 11 Pallet Define Window  

4. Whenever you leave each cell after modifying it, CubeMaster saves the changes to the pallet 

database automatically 

Define a new Pallet 

To define a new pallet, follow these instructions; 

1. Click the New button 

System Response: A new row is appended at the bottom of the list and the focus locates on the 

Name cell 

2. Modify information of each cell as you necessary 

3. Whenever you leave each cell after modifying it, CubeMaster saves the changes to the pallet 

database automatically 

Delete an pallet from the database 

To delete an existing pallet, follow these instructions; 

1. Select rows of the pallet you want to delete 

2. Click the row-number heads to highlight the rows 

System Response: The Delete button is activated 

3. Click the Delete button 

System Response: The selected rows are deleted from the database and removed from the list 



  

Truck Databases 

The Truck Database view allows you to define a new truck or modify an existing truck. In this view, you 

enter truck parameters and save it to the truck database. Start from the Task Bar and click the Database menu 

and select Truck. 

System Response: The Truck Database view appears. 

The Truck Database view is comprised of the following components: 

¶ New Button: Allows you to define a new truck.  

¶ Delete Button: Allows you to delete trucks from the database. This button will be activated on when 

you select more than one truck at the Truck List. In order to make a selection, click a row header of 

the leftmost column at the list and drag the mouse to the end of range. The list will highlight the 

range and the button activates. 

¶ Truck List: Displays a list of all trucks existing in the database. It allows you to modify the 

parameters of truck and saves the changes to the database automatically. 

Truck List  

When you click on a truck data, a black bar highlights it. The gray vertical scroll bar to the right of the box 

scrolls the database list and allows you to view more trucks. The scroll bar will take you to the bottom of the 

list or to the top of the list. When you click on a cell, a black color highlights it and be ready for you to enter a 

new value. If you enter a return key when you complete to type a value, the right cell will gain the highlight 

again. 

This list contains useful information about the truck.  

¶ Define Button [é]: This column allows you to define more parameters of truck. 

¶ Name: This column contains the truck name.  

¶ Alias1: This column contains the alias of each truck. 

¶ Length, Width and Height: This columns display the dimensions of each truck. The dimensions will 

appear either in English or Metric units, depending on which units are selected in the Toolbar. 

¶ Weight: This column displays the defined weight of each truck. As with the dimensions columns, 

this column will either appear in English or Metric units, depending on which units are selected in 

the Toolbar. 

¶ Max Weight: This column displays the max weight of each truck. As with the dimensions columns, 

this column will either appear in English or Metric units, depending on which units are selected in 

the Toolbar. 

¶ Price: This column displays the defined price of each truck.  

¶ Max Price: This column displays the max price of each truck.  

¶ Color: This column displays the color of each truck. Click on this column to display the Color 

Selection dialog box. CubeMaster uses the standard (48-color) Windows Color Selection dialog 

box, which allows you to select a custom color for each truck.  

Modify an existing truck  

To modify an existing truck, follow these instructions; 

1. Select a row of the truck you want to modify 

2. Modify information of each cell as you necessary 

3. Or click the Define button [é] 



  

System Response: The Truck Properties window appears and allows you to define more parameters 

of the truck 

 

Figure 12 Truck Define Window  

4. Whenever you leave each cell after modifying it, CubeMaster saves the changes to the truck 

database automatically 

Define a new truck 

To define a new truck, follow these instructions; 

1. Click the New button 

System Response: A new row is appended at the bottom of the list and the focus locates on the 

Name cell 

2. Modify information of each cell as you necessary 

3. Whenever you leave each cell after modifying it, CubeMaster saves the changes to the truck 

database automatically 

Delete an truck from the database 

To delete an existing truck, follow these instructions; 

1. Select rows of the truck you want to delete 

2. Click the row-number heads to highlight the rows 

System Response: The Delete button is activated 

3. Click the Delete button 

System Response: The selected rows are deleted from the database and removed from the list 



  

Sea Van Databases 

The Sea Van Database view allows you to define a new sea van or modify an existing sea van. In this view, 

you enter sea van parameters and save it to the sea van database. Start from the Task Bar and click the 

Database menu and select Sea Van. 

System Response: The Sea Van Database view appears. 

The Sea Van Database view is comprised of the following components: 

¶ New Button: Allows you to define a new sea van.  

¶ Delete Button: Allows you to delete sea vans from the database. This button will be activated on 

when you select more than one sea van at the Sea Van List. In order to make a selection, click a 

row header of the leftmost column at the list and drag the mouse to the end of range. The list will 

highlight the range and the button activates. 

¶ Sea Van List: Displays a list of all sea vans existing in the database. It allows you to modify the 

parameters of sea van and saves the changes to the database automatically. 

Sea van List  

When you click on a sea van data, a black bar highlights it. The gray vertical scroll bar to the right of the box 

scrolls the database list and allows you to view more sea vans. The scroll bar will take you to the bottom of 

the list or to the top of the list. When you click on a cell, a black color highlights it and be ready for you to 

enter a new value. If you enter a return key when you complete to type a value, the right cell will gain the 

highlight again. 

This list contains useful information about the sea van.  

¶ Define Button: This column allows you to define more parameters of sea van. 

¶ Name: This column contains the sea van name.  

¶ Alias1: This column contains the alias of each sea van. 

¶ Length, Width and Height: This columns display the dimensions of each sea van. The dimensions 

will appear either in English or Metric units, depending on which units are selected in the Toolbar. 

¶ Weight: This column displays the defined weight of each sea van. As with the dimensions columns, 

this column will either appear in English or Metric units, depending on which units are selected in 

the Toolbar. 

¶ Max Weight: This column displays the max weight of each sea van. As with the dimensions 

columns, this column will either appear in English or Metric units, depending on which units are 

selected in the Toolbar. 

¶ Color: This column displays the color of each sea van. Click on this column to display the Color 

Selection dialog box. CubeMaster uses the standard (48-color) Windows Color Selection dialog 

box, which allows you to select a custom color for each sea van.  

Modify an existing sea van 

To modify an existing sea van, follow these instructions; 

1. Select a row of the sea van you want to modify 

2. Modify information of each cell as you necessary 

3. Or click the Define button 

System Response: The Sea Van Properties window appears and allows you to define more 

parameters of the sea van 



  

 

Figure 13 Sea Van Define Window  

4. Whenever you leave each cell after modifying it, CubeMaster saves the changes to the sea van 

database automatically 

Define a new sea van 

To define a new sea van, follow these instructions; 

1. Click the New button 

System Response: A new row is appended at the bottom of the list and the focus locates on the 

Name cell 

2. Modify information of each cell as you necessary 

3. Whenever you leave each cell after modifying it, CubeMaster saves the changes to the sea van 

database automatically 

Delete an sea van from the database 

To delete an existing sea van, follow these instructions; 

1. Select rows of the sea van you want to delete 

2. Click the row-number heads to highlight the rows 

System Response: The Delete button is activated 

3. Click the Delete button 

System Response: The selected rows are deleted from the database and removed from the list 



  

ULD Databases 

A ULD is defined as Unitload Device or air pallet that you will fill with Cargoes.  

The ULD Database view allows you to define a new ULD or modify an existing ULD. In this view, you enter 

ULD parameters and save it to the ULD database. Start from the Task Bar and click the Database menu and 

select ULD. 

System Response: The ULD Database view appears. 

The ULD Database view is comprised of the following components: 

¶ New Button: Allows you to define a new ULD.  

¶ Delete Button: Allows you to delete ULDs from the database. This button will be activated on when 

you select more than one ULD at the ULD List. In order to make a selection, click a row header of 

the leftmost column at the list and drag the mouse to the end of range. The list will highlight the 

range and the button activates. 

¶ ULD List: Displays a list of all ULDs existing in the database. It allows you to modify the 

parameters of ULD and saves the changes to the database automatically. 

ULD List   

When you click on a ULD data, a black bar highlights it. The gray vertical scroll bar to the right of the box 

scrolls the database list and allows you to view more ULDs. The scroll bar will take you to the bottom of the 

list or to the top of the list. When you click on a cell, a black color highlights it and be ready for you to enter a 

new value. If you enter a return key when you complete to type a value, the right cell will gain the highlight 

again. 

This list contains useful information about the ULD.  

¶ Define Button: This column allows you to define more parameters of ULD. 

¶ Name: This column contains the ULD name.  

¶ Alias1: This column contains the alias of each ULD. 

¶ Length, Width and Height: This columns display the dimensions of each ULD. The dimensions will 

appear either in English or Metric units, depending on which units are selected in the Toolbar. 

¶ Weight: This column displays the defined weight of each ULD. As with the dimensions columns, 

this column will either appear in English or Metric units, depending on which units are selected in 

the Toolbar. 

¶ Max Weight: This column displays the max weight of each ULD. As with the dimensions columns, 

this column will either appear in English or Metric units, depending on which units are selected in 

the Toolbar. 

¶ Color: This column displays the color of each ULD. Click on this column to display the Color 

Selection dialog box. CubeMaster uses the standard (48-color) Windows Color Selection dialog 

box, which allows you to select a custom color for each ULD.  

Modify an existing ULD 

To modify an existing ULD, follow these instructions; 

1. Select a row of the ULD you want to modify 

2. Modify information of each cell as you necessary 

3. Or click the Define button and enter extra parameters including shape of the ULD 

System Response: The ULD Properties window appears and allows you to define more parameters 

of the ULD 



  

 

Figure 14 ULD Define Window  

4. Whenever you leave each cell after modifying it, CubeMaster saves the changes to the ULD 

database automatically 

Define a new ULD 

To define a new ULD, follow these instructions; 

1. Click the New button 

System Response: A new row is appended at the bottom of the list and the focus locates on the 

Name cell 

2. Modify information of each cell as you necessary 

3. Whenever you leave each cell after modifying it, CubeMaster saves the changes to the ULD 

database automatically 

Delete an ULD from the database 

To delete an existing ULD, follow these instructions; 

1. Select rows of the ULD you want to delete 

2. Click the row-number heads to highlight the rows 

System Response: The Delete button is activated 

3. Click the Delete button 

System Response: The selected rows are deleted from the database and removed from the list 



  

Define Simulation 

Introduction 

This chapter explains how to use CubeMaster to define a simulation. 

Note: Be aware that you'll see different screens depending on the simulation type you selected from the 

Simulation Type window even this chapter explains the Sea Van simulation. 

Open the Setup View 

Use one of three options in order to open this view. 

¶ Select a simulation type from the Simulation Type window after click the Start button on the Today 

View 

¶ Open the View menu and select Setup. 

¶ From the Task List, click Setup button. 

System Response: The Setup View appears as picture below; 

 

Figure 15 Setup View 

Structure of  Setup View 

With the setup view displayed, youôre ready to begin defining the components of a new simulation. This view 

is the basis for collecting data for building a new simulation. The setup view is comprised of the following 

components: 

Á Buttons Group: Allows you to perform command for the simulation.  

Á Step 1: Sea Van Group: Allows you to define the types of sea vans to be used for the simulation. As 

you add new sea vans by click Add button, they will automatically appear in the sea van list.  




































































